
Ministry Licensed Software Subject Division Research Process 

Title Sc&
T SS Pr Jr Int Research Stage 

       

• Acadia  •    Preparing, Accessing 

• L’Acadie  •    Preparing, Accessing 

• Adventure Canada  •    Preparing, Accessing 

• AppleWorks 5 • •    Preparing Processing, Transferring 

• 1998 Canadian and World Book Encyclopedia • •    Preparing, Accessing 

• Canadian Geographic Explorer  •    Preparing, Accessing 

• Claris HomePage 3.0 • •    Transferring 

• Clicker 4 • •    Processing, Transferring 

• Corel WordPerfect Suite 10 • •    Preparing, Processing, Transferring 

• Co—Writer 4000 • •    Preparing, Processing, Transferring 

• Cross Country Canada  •    Accessing, Processing, Transferring 

• Digital Fieldtrip to the Rainforest •     Preparing, Accessing 

• Digital Fieldtrip to the Wetlands •     Preparing, Accessing 

• Dragon Naturally Speaking • •    Preparing, Processing, Transferring 

• Earthquest • •    Preparing, Accessing 

• Encyclopedie des animaux et de la nature •     Preparing, Accessing 

• Encyclopedie des sciences •     Preparing, Accessing 

• Explore Canada  •    Preparing, Accessing 

• Eyewitness Encyclopedia of Nature •     Preparing, Accessing 

• Eyewitness Encyclopedia of Science •     Preparing, Accessing 

• Eyewitness Encyclopedia of Space • •    Preparing, Accessing 

• FileMaker Pro  • •    Processing, Transferring 

• Fortress of Louisburg  •    Preparing, Accessing 

• Dreamweaver • •    Transferring 

Ministry Licensed Software—Subject/Division/
Research Stage Chart 



Ministry Licensed Software Subject Division Research Process 

Title Sc&
T SS Pr Jr Int Research Stage 

       

• Graphers • •    Processing, Transferring 

• Great Canadian Scientists • •    Preparing, Accessing 

• Hyperstudio 4 • •    Transferring 

• Interactive Science Encyclopedia •     Preparing, Accessing 

• Kidpix • •    Processing, Transferring 

• Light and Sound •     Preparing, Accessing 

• Making History: Louis Riel  •    Preparing, Accessing 

• Microsoft Publisher • •    Processing, Transferring 

• My First Incredible Amazing Dictionary • •    Preparing, Accessing, Processing 

• Northwest to the Pacific: A Fur Trade Odyssey • •    Preparing, Accessing 

• Un Odyssee de la Traite des Fourrures • •    Preparing, Accessing 

• Pioneers • •    Preparing, Accessing 

• Prime Ministers of Canada • •    Preparing, Accessing 

• Sammy, la maison des sciences •     Accessing, Processing 

• Sammy’s Science House •     Accessing, Processing 

• Science Court—Electric Circuits •     Preparing, Accessing, Processing 

• Science Court—Work & Simple Machines •     Preparing, Accessing, Processing 

• Science Sleuths      Preparing, Accessing, Processing 

• Smart Ideas—graphic organizer • •    Preparing, Accessing, Processing, 
Transferring 

• Star Office • •    Preparing, Accessing, Processing, 
Transferring 

• The Way Things Work • •    Preparing, Accessing 

• Write Outloud 3 • •    Preparing, Accessing, Processing, 
Transferring 

•        

Ministry Licensed Software—Subject/Division/
Research Stage Chart  (continued) 
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STUDENTS ADDING IMAGES FROM THE INTERNET TO DOCUMENTS 
 

 
Students can import images from the Internet by using the copy and paste commands.  To do 
this: 
 
1. Have the document on the screen to which the student wants to add the Internet image, for 

example MSPublisher, Student Writing Centre, HyperStudio, etc.   
 
2. Minimize this program by clicking on the Minimize button in the top right corner of the 

screen. (It looks like a small line).   
 
 
 
 
 
3. Launch Internet Explorer.  Locate the desired image...either by doing a search using a 

search engine (for e.g., Yahooligans) or by typing the appropriate web address in the top 
window.   

 
4. Right-mouse click on the image, then select Copy from the shortcut menu that appears 

(use the left mouse button to select Copy).  
 
5. Now, maximize the document that was previously minimized...it has become a button at 

the bottom of the screen...just single click on it. 
 
6. Click on Edit in the top menu of this document and select Paste or sometimes, it’s Paste 

Picture (or click <Ctrl> V). 
 
7. The image can now be moved or re-sized, as desired. 
 
 
NOTE:  Be aware of copyright infringement.  Some websites allow the free use 
of their images.  However not all websites do. Sometimes, you are asked to give 
credit in your document, to the website from which you got the pictures.  Look 
for the information about the use of a particular website’s content that is 
available on most websites.   
 
 
 
 
 
 
 
 
* "Clip art licensed from the Clip Art Gallery on DiscoverySchool.com"  
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CREATING WEB LINKS IN APPLEWORKS AND WORDPERFECT 
 

IN APPLEWORKS 5 and 6 
 
1. Launch AppleWorks 5 and select the Word Processor. 
2. Type a title, or the name of a website or the actual website address.  For example, to create a 

weblink for the children’s search engine, Yahooligans, you could type the title: Children’s 
Search Engine, or the name, Yahooligans, or the website address, www.yahooligans.com 

3. Highlight the text, then click on the New URL Link button on the button bar.        (It looks 
like a hand with a globe on top if it.)  

      Note: in AppleWorks6, the icon looks like a globe with 2 chain links on it. 
  
4. In the New URL Link dialogue box, 

type the web address in the URL 
window. Then click OK. 

 
 
 
 
 
 
 
5. The text now becomes ‘hypertext’.  When the mouse is passed over the text, the arrow 

pointer changes to a selection cursor.  Click on the text to access the website. 
 
 
IN WORDPERFECT 
 
1. Launch WordPerfect. 
2. A) Type the website address (see AppleWorks example above). Press the spacebar to  
           activate the link.  OR 
      B) To use a title or website name rather than the address: 

• Type the title, then highlight the text, for example: Just For Kids Who Love Books 
• Select Tools from the top menu, then select Hyperlink (or click on the Hyperlink 

button on the 
toolbar...it looks 
like a spider web 
with two chain 
links under it) 

• Type the URL in 
the Document/
Macro window. 
Then click OK. 
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Useful Websites - Differentiated Learning in the Classroom 
 

THE ASSOCIATION FOR SUPERVISION AND CURRICULUM DEVELOPMENT 
(ASCD) www.ascd.org 
 
An international organization that addresses all aspects of teaching and learning; click on the link, 
“Differentiating Instruction”, for articles and resources for an effective differentiated classroom 
 
 
NATIONAL CENTRE FOR LEARNING DISABILITIES 
http://www.ld.org/ 
 
Includes information about what a learning disability is, as well as tips for parents and teachers 
about how to deal with LD students 
 
 
GIFTED: A GOOGLE WEB DIRECTORY LISTING OF WEBSITES FOR THE 
GIFTED STUDENT 
http://directory.google.com/Top/Reference/Education/K_through_12/Gifted_Educ
ation/ 
 
Includes links to many sites to support the gifted learner…articles, teaching strategies, programs 
 
SPECIAL NEEDS OPPORTUNITY WINDOWS 
http://snow.utoronto.ca/ 
 
The Resources section includes adaptive programming and lesson plans (thematic planning 
units) designed to include special needs students in the regular classroom 
 
 
DIFFERENTIATED INSTRUCTION – UNIVERSITY OF ALBERTA  
http://www.quasar.ualberta.ca/ddc/incl/difinst.htm 
 
An easy to follow outline about differentiated instruction that includes consideration of the 
student’s physical environment and materials, the teacher’s methods of instruction, and provides 
a list of ways students can participate in their learning 
 
 
TEACH-NOLOGY: THE WEB PORTAL FOR EDUCATORS 
http://www.teach-nology.com/litined/dif_instruction/ 
 
Lists a variety of ERIC and other document links related to differentiated instruction  
 
 
SPECIAL EDUCATION – GOVERNMENT OF BRITISH COLUMBIA 
http://www.bced.gov.bc.ca/specialed/   
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An extensive website that provides information about students with special needs including 
disabilities of an intellectual, physical, sensory, emotional or behavioural nature, or learning 
disability or exceptional gifts or talents.   

 LD ONLINE  
 http://www.ldonline.com/ 
  
Offers a variety of articles about the learning disabled student and instructional strategies that can 
be incorporated into the regular classroom 
   
COUNCIL FOR EXCEPTIONAL CHILDREN 
http://www.cec.sped.org/bk/  
 
Search for articles and publications from the CEC  
 
 
SMART TECHNOLOGIES 
http://www.smarttech.com/education/specialed.asp 
 
Provides information on Smart Board technology and how the Ministry licensed concept mapping 
software, Smart Ideas, can be used to assist special needs students 
 
AROGA-ASSISTIVE DEVICES 
http://www.aroga.com/learning/learning.asp 
 
A commercial site that sells educational software, including special education products; can 
search by category 
 
MICROCOMPUTER SCIENCE CENTRE INC. 
http://www.microscience.on.ca 
 
A commercial website for specialized software; products are categorized by disability/need  
 
EDUCATOR’S TOOLKIT >>> TEACHER RESOURCES LINK >>> SPECIAL 
EDUCATION SECTION 
http://www.eagle.ca/~matink/teacher.html#GEN  
 
An Ontario site that categorizes needs/exceptionalities into 7 types, with detailed information for 
each type; also contains a list of other special needs websites 
 
INTERNET RESOURCES FOR SPECIAL CHILDREN (IRSC) 
http://www.irsc.org 
 
A plethora of info on special needs students including support and rehabilitation, sports, etc. 
 
SET-BC LEARNING CENTRE 
http://www.setbc.org/setbc/topics/topics_classroom.html 
 
Online workshops, webcasts and tutorials related to software and other technologies 
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Success for All Students—Technology and General Teaching Strategies  
For Special Needs Students 

 
 

• Begin with the concrete, then relate the abstract to it—e.g. use hoops from the 
gym to make a Venn Diagram in order to compare 2 (or 3) topics/criteria; then 
transfer this learning to a more abstract yet still visual representation using 
Kidpix, MS Publisher or graphic organizer 

 
• Many software programs assist special needs students by offering information in 

a variety of formats: print, oral explanations, and visual presentation—e.g. My 
First Amazing Picture Dictionary, or Light and Sound 

 
• Computer simulation games provide links between classroom learning and the real world, 

for example, Mathville 
 
• Problem-solving games are motivating, yet allow students to use various problem-solving 

techniques, with and without assistance; having students orally communicate how they 
solved the problem extends the learning process, e.g. Math Circus   

            NOTE: Provide structure to this problem solving activity by having students log   
            their activities on a tracking sheet 
 
• Keep routines consistent in the computer lab (just as you do in the classroom), e.g. entering/

exiting procedures, beginning the class with instructions on their assignments, giving 
advanced notice of how much time they have remaining to work, etc. 

 
• For students requiring modifications and accommodations to their programs, decide ahead 

of time what are the “must knows” or “must do’s” for that student — then identify the best 
format to help that student achieve success, e.g. graphic organizers are excellent for 
identifying important information in an organized way; as well, the graphic format often 
assists students to remember the information that is presented 

 
• Self-help tutorials, where students can control the speed/amount of information presented, 

are especially helpful to special needs students; they can pace themselves, review concepts 
of which they are uncertain and practise concepts until they understand them, e.g. Math 
Trek 4,5,6 

 
• Word processors provide opportunities to edit reports and stories with less “pain” than 

conventional ‘rubbing and rewriting’ - refer to the brochure, Computers and the Writing 
Process  

 
• Presentation software, e.g. Kidpix Slideshow, HyperStudio, Star Office-Impress assists 

communicational students with an opportunity to present information in a dynamic format 
without the stress of standing up in front of the class and speaking  

                                                                                                                        continued>>> 
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• Refer to the Teacher Companion in the Ontario Curriculum Unit Planner.  
There is a plethora of information: teaching/learning strategies, 
accommodations and background information related to special needs 
students.  Teacher Companion also contains graphic organizers that can be 
printed out and duplicated for the classroom. 

 
• There are many software packages to assist special needs students with 

literacy development.  Some of these are Ministry licensed and are available 
for free to publicly funded schools in Ontario.  Others are not Ministry 
licensed and must be purchased.  Depending on the situation, ISA grants can 
be used for the purchase of adaptive software.  Refer to the chart, Special 
Needs Software, for more specific information. 

 
• EQAO Accommodations— Some special needs students are allowed to use a computer in 

certain circumstances...check the EQAO documentation for more information about this 
 
 
 
 
 
 
 
 
 
 



D espite the efforts by teachers to make 
the writing of stories and reports a positive 
experience, the writing process can be difficult 
and frustrating for many students for a 
number of reasons.  While they often have 
good ideas for the content of their writing, 
many students have difficulty when it comes 
to organizing and sequencing these ideas 
correctly.  As well, developing an idea from 
one sentence into a more detailed paragraph 
can prove to be a challenge.  Further, one of 
the biggest frustrations is the editing of text by  
hand: the tedious job of erasing, correcting  

 
and rewriting manually. For 
numerous students, there is the 
tendency to use smaller, ‘plain’ 
words in their writing to avoid 
spelling errors.  Ideas used by 
the students may be limited 
when they think about the amount of time and 
effort that will be needed for manual revisions. 
Computers are wonderful tools to assist 
students to deal with all of these issues, as 
well as to provide innovative ways to publish 
their work. 
 
"Clip art licensed from the Clip Art Gallery on DiscoverySchool.com"  

 
Why use computers in the writing process? 
 
• students can create legible text immediately...a great advantage, especially for those who 

have difficulty with handwriting or printing 
 
• editing tools make revisions far easier, faster and less tedious 
 
• by using an electronic graphic organizer, students have more flexibility with regards to the 

type and size of the organizing template that they use—webs, flow-charts, sequence charts, 
etc., can all be created and modified quickly and easily  

 
• electronic graphic organizers will allow the automatic conversion of the diagram view to an 

outline format that can be readily modified 
 
• the availability of many fonts, styles, sizes, colours, etc., promotes student self-expression 
 
• by being successful in their planning and writing, students are more likely to continue to 

expand their writing skills; thus, computers as writing tools are highly motivational 
 
• electronic writing and publishing addresses students’ different learning styles: kinesthetic 

and spatial learners benefit from the hands-on keyboarding and mouse-clicking, visual 
layouts, graphics, scrolling text, text styles, sound, animation, etc. 

 
• by using collaborative communication software (e.g., First Class) students can write for an 

expanded audience and receive feedback on their ideas from an extended peer group 
 
• many Internet sites offer opportunities to post students’ writing including creative writing 

stories and non-fiction reports and presentations; thus students write in a variety of formats 
for a variety of audiences 

1 
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Some Ideas for Authentic Writing for Specific Purposes 
 
1. Electronic storybooks using Corel Presentations, HyperStudio, Storybook Weaver, etc...as well, 

older students can create electronic storybooks for younger students 
2. Student-created Writers’ Dictionaries that include story-starter words, transition words, parts of 

speech, theme words, etc.; these can be created using a desktop publisher or word processor in 
which the pages are printed out and compiled into a binder or bound into a book format. Or they 
can be a multimedia presentation using Corel Presentations, HyperStudio, KidPix slideshow, etc.  

3. Multimedia or desktop published yearbooks, classroom newsletters, autobiographies 
4. Culminating reports or products in various formats including brochures, menus, calendars, flyers, 

posters, catalogues...created using MSPublisher templates 
5. Webpages involving cross-curricular writing, for e.g., Canadian Government, Explorers, the solar 

system, etc.; writing on the web encourages students to be succinct and precise in their 
language, and demands attention to order and flow of ideas (because of hyperlinks in which the 
reader jumps from one segment to another) 

6. Online conferencing projects (e.g., using FirstClass) between classes and/or schools, to gather/
share information, compare viewpoints, respond to stories read, etc. in a 
controlled setting.  If desired, each student’s entries can be tracked and 
assessed over time, by the teacher. 

 

The Writing Process Tasks Suitable Software 

Pre-Writing • generate ideas 
• organize ideas 
• create a writing plan 
• determine audience 

⇒ Graphic organizer (e.g., Inspiration, 
Kidspiration) 

⇒ Desktop Publisher (e.g., MSPublisher) 
⇒ Paint program (e.g., KidPix, AppleWorks) 

Writing a Draft 
Revising 
Editing 

• write initial draft using organizer/outline 
writing plan 

• clarify ideas 
• improve organization 
• improve language 
• improve style 
• correct spelling, grammar and punctuation 
• peer and teacher editing 

⇒ Word Processor/Desktop Publisher (e.g., 
WordPerfect, AppleWorks, Student Writing 
Centre, StoryBook Weaver, EasyBook, 
MSPublisher) 

⇒ Multimedia presentation software (e.g., 
Corel Presentations, KidPix Slideshow, 
HyperStudio, AppleWorks Slideshow) 

⇒ Webpage design software (e.g., 
Dreamweaver, Claris HomePage) 

Publishing • reflect on most appropriate venue for 
intended audience 

• enhance finished product using appropriate 
tools and formats, for e.g., graphics, text 
font and style, sound, animation, borders 
and margins, etc. 

⇒ as above 
 

Self-Evaluation • seek feedback 
• reflect on ability to successfully 

communicate intended message 

⇒ journal entry using a word processor 
⇒ conferencing with peers using electronic 

conferencing software (e.g., First Class) 

NOTE: Because of the ease of revising and editing writing using a word processor or similar software, it is recommended 
that the computer be used for all stages of the writing process, not just the final product.  Text can be entered directly into 
the desired software (for example, typing into the brochure template in MSPublisher). Or, revised text can be copied and 
pasted from one computer application to another. For example, individual sentences or paragraphs originally generated in 
a report using a word processor can be copied and pasted into individual slides in a multimedia presentation.  
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A Word About Keyboarding 

 
In order to make effective use of computers in the writing process, students should develop 
proficient keyboarding skills. The 'hunt and peck' approach to typing restricts their ability to attend 
to the content and structure of their writing.  Proper keyboarding technique cannot be acquired 
incidentally. Rather, systematic, supervised practice that combines some teacher instruction with the 
use of keyboarding tutoring software, such as All The Right Type, needs to be implemented. Even 
classroom teachers who do not themselves touch-type can assist their students to become 
competent keyboarders with the help of keyboarding software.  Ideally,  students should spend 15-20 
minutes several times a week practising keyboarding skills beginning in Grade 4 (or the latter stages 
of Grade 3).  Home practice, keyboarding clubs, etc., would also improve their skills.  Although 
students do not have take-home privileges for All the Right Type under our school-license, the 
distributor, Ingenuity Works, offers very reasonable rates for student purchase of this software. 
Keyboarding is a lifelong skill for students, the value of which cannot be underestimated.  

If a student writes a story or report that ‘jumps  all 
over’, have him/her  identify orally the topics or key 
ideas that are being addressed in his/her work. Write 
these ‘headings’ below the story, typing the text in a 
different colour for each heading. Next the student 
reads each sentence in his/her story and changes the 
colour of the text in each sentence to match the 
heading colour. Now the student can cut and paste 
sentences of the same colour together. (Some fine-
tuning might be necessary to order the sentences 
within each of the topics.) If  appropriate opening and 
closing sentences are not already in the report or 
story, these can be added. 

Editing/Revising Strategies 
 
• A useful strategy for peer and teacher editing, is the use of the comment bubbles when editing 

electronically. An editor can add his/her own suggestions and thoughts without changing the 
piece of work they are reviewing.  For example, in WordPerfect, the editor places the cursor in 
the location in the story where he/she would like to make a suggestion. Then the editor clicks 
Insert, Comment and types the suggestion in the window that appears.   A small comment icon 
appears in the margin of the work being edited. The document is then resaved.  By clicking on 
the comment icon, the author can read the editor’s suggestions and make the appropriate 
changes: 

• For word processors that do not offer the ‘Insert Comment’ feature, for e.g., in AppleWorks, the 
editor can always create a text box in the margin and add suggestions using a different 
coloured text. 

Encourage the use of the language tools such as 
spell checker, grammar checker and thesaurus in 
word processors. These tools do not deter the 
learning of correct spelling and grammar.  Rather, 
they draw the student’s attention to mistakes and 
offer possible solutions. This requires decision-
making by the student.  Students should be 
cautioned that these tools are not foolproof.  
Sometimes, words are misspelled in a manner that 
restricts the spell checker’s ability to provide the 
correct spelling.  As well, a word may be spelled 
correctly, but is the incorrect word for that 
particular context (e.g., a homonym). 

3 



Using Electronic Graphic Organizers in the Writing Process  
 
1.  For a simple paragraph, use a web organizer to brainstorm ideas on a particular event, story or 

subject. Remember, these are single words or short phrases...not full sentences. Colour coding will 
help the students to differentiate the various parts: one colour for the title, another colour for the 
topic and concluding sentences and a third colour for related sentences.   

⇒      For their first draft, using a word processor, students colour code their sentences to match   
         their organizer. 
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2. A detailed paragraph joins 
detail ideas to related ideas. 

 
         Again, use colour   
         coding to differentiate parts  
         of the paragraph. 

Prior to students writing their 
initial draft, discuss/brainstorm a 
list of joining words to help the 
sentences flow. 

* Organizers and outlines in this brochure were created using Smart Ideas software 
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Most graphic organizer software allows users to automatically convert their organizer into an outline: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Students can then change their point form notes into complete sentences directly on the outline, if 
desired. Then they copy and paste these sentences into a word processor or other software program 
for their initial draft.  (Or they can begin writing their first draft in a word processor, using the original 
point form organizer without using the outline feature.) 



3. For report writing where research is involved, students can use a graphic organizer to 
brainstorm areas of focus that they would like to find out more about, related to a topic. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
As they gather Information, it can be added to the organizer, in point form, and attached to the 
appropriate area of focus.  Additional areas of focus can also be added at this time.  The diagram 
can then be converted to outline form, if desired, prior to writing the first draft of the report. 
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4. This is a sample organizer template that could be created by the teacher for students to use in  
the pre-writing stage, in order to plan out their creative writing stories.  Alternatively, students 
can generate their own story organizer by using graphic organizing software. 

 

5. Graphic organizer templates can be used for various types of poetry. Here is a diamante 
poetry template. 

 
 
 

8 
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Expand/Contract Style Pal-

Standard Toolbar 

Formatting Toolbar 

Style Palette 

Hide Formatting Toolbar 

Connector Formatting Buttons 

Workspace Views 
Diagram-Used most often for creating diagrams 
Outline-View text version of your diagram. This view provides ready made outline 
students can use to organize their writing, brainstorm and develop connected ideas and 
then toggle to the diagram view when they’re ready. Any editing in outline view will be 
reflected in the diagram view. 
Global View–Provides a useful overview in a two-dimensional depiction of all your 
work including all the sublevels of your diagram. 

 
Smart Ideas 
 Quick Reference
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Creating a Diagram 
Symbol is a graphical object, e.g. circle, square, picture that encloses a text message. 
 
Enhancing a Symbol 
• Use different colours 
• Use different shapes 
• Integrate an image 
• Use Smart Ideas clip art library 
 
Creating Symbols 
Begin Smart Ideas 
Click Open Button 
Type in the new untitled workspace, your text will appear inside a text box. 
Press Enter on your keyboard, now text will appear in a circle 
 
If you continue to type and press ENTER-you will see a diagram of overlapping, disconnected symbols that you can arrange 
and connect later. 
 
Quick Connect Feature 
Great for a brainstorming session 
1. Click Quick Connect Button 
2. Layout-Click Layout dropdown arrow and select one of the six patterns before you start creating the diagram. You may 

change this layout at a latter date. Make sure the APPLY  TO ENTIRE PAGE check box is selected. 
3. Enter your first topic (Primary Symbol), when you connect another symbol, it will 
automatically connect to the primary symbol. 
 
Your Symbols must contain TEXT. (Blank symbols can’t be part of your diagram in the 
Quick Connect Feature). 
 
The Shape and Colour of the symbol is determined by the selected symbol style. 
 
 
 

Linking Symbols with Connectors 
1. Connector lines link symbols together-Click the connector button and drag the connector to the symbol. 
2. Connectors move with their symbols unless the relationships change between symbols. 
3. The style of connector chosen remains until you select a new style. 
4. Connectors may be..  

• labeled or unlabeled 
• Thin or thick 
• Solid or dashed 
• Straight, angled or curved 
• Include arrowheads 
• Include whimsical designs (Connector Style Button under Format in the toolbar.) 

 
Labeling Connectors 
Why? You may want to label connectors with text to further clarify and explain the relationship be-
tween two symbols. 
1. Select the connector 
2. Click once 
3. A text box will appear 
4. Type your label 
5. Enter 
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Selecting Symbols and Connectors 
Selection can be made before you begin your diagram 
You may change more than one symbol at a time...Click SELECT ALL on the EDIT menu. 
1. Cursor over object and click once 
2. If object is a symbol you will see the following icons appear. 
3. To select multi elements of the diagram hold your shift key or click and drag your mouse around all the symbols and con-

nects you want to modify. 
4. Double click on the symbol or connector to view label. 

 
 
 

 
 
 

 
 
 
 
 
 
 

 
Moving Diagram Objects 
1. Moving One Symbol-Click on only one and drag your mouse to place, all connectors will follow. 
2. Entire Diagram, Select all objects (drag the mouse pointer over the diagram and draw a rectangle, press and hold mouse 

button and drag into place. 
3. If you want to stack symbols on top of each other go to VIEW > Show Sublevels (unchecked). 
 
Reshaping a Curved Connector 

1. Click onto your connector 
2. Select the line icon in the toolbar menu and click on the curved line. 
3. Your Connector will now have a square button you can click and drag to make it curve. 

 
 
 
 
 
 
 
 
 
 

 
Aligning Objects 
1. Select objects 
2. Select ALIGN from the FORMAT menu 
 
Deleting Objects. 
Note Effects… 
1. If hyperlink is added or files linked they will be lost 
2. If symbol has one or more sub-levels they will be deleted 
3. If you delete a connector the symbols will remain. 
 
Deleting, Cutting, Copying and Pasting Objects– Undo and Redo 
1. Deleting-select one or more objects and click on DELETE button on the toolbar. 
2. Cutting, Copying and Pasting Objects similar to other programs, Note-if you’re copying a symbol with an associated sub-

level it will ask you if you want to copy those levels. 
 
Protecting Objects from Editing 
You can make objects or the entire areas non editable 
1. Select one or all objects 
2. Select TOOLS in menu and select Make Background 
3. To restore select TOOLS and RETRIEVE BACKGROUND 

Collapse Diagram Open Sub 

Resize 
Click, hold and drag to enlarge or contract sym-
bol. 
To resize the entire group select all and resize 
one object, the rest will resize as well, release 
mouse to view. For longer text you may also 
attach a note. 

Create a Connector 
• Select the blue circles on 

each end to move con-
nectors. 
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Creating Styles 
Create a New Symbol 
1. Click Symbols Button 
2. Click style you want to use in the Style palette 
3. Click in workspace and type. 
4. Creating a style without text-drag and drop the style into the workspace 
 
To change an existing symbol 
1. Select a symbol in the workspace 
2. Click SYMBOLS button above the Style palette 
3. Select new style 
 

 
Modifying Existing Styles and Creating New Styles 
1. Select Style 
2. Select Customize Button 
3. Select Font, Fill, Colour, Shape or Transparency 
 
Any symbols that you created using the original style 
will immediately change to reflect the new characteris-
tics of the changed style. 
 
Add Style to Palette from the Tools Menu 
1. Create new Symbol 
2. Add Style to Palette from Tools Menu 
3. Name new style 

 
 

 
 
 
Changing Symbol Appearance 
To create a symbol style that you can use again and again, select the sym-
bol and then select.  Add Style to Palette from TOOLS menu. Your 
unique symbol will be added to the Style palette for future use. 
 
To Customize the fill, shape and outline of a symbol using the Formatting toolbar. 
1. Select one or more connectors 
2. Click the CONNECTOR TYPE button 
3. Change> Line Thickness button> Line Colour > Arrow Style > Use Deluxe Connector 

 
Add a two Colour Pattern/Gradients 
1. Select symbol 
2. Click Fill Colour on formatting toolbar 
3. Click Fill Effects 
4. To add a gradient fill, click the Gradients tab and click a gradient type. 

 
 
 

Click a pattern type 

Preview of Pattern and Colours 

Click to select the two colours for the pattern. 

Adding a Note to a Symbol 
If you want to add a few lines of 
explanation, reference a source 
or just add a few lines of com-
mentary to a symbol, add a note 
 
NOTE ICON appears on the 
symbol even when not selected, 
if you hover over a note icon 
contents will appear on your 
screen. 



Adding a Note to a Symbol 
If you want to add a few lines of explanation, reference a source or just add a few lines of commentary to a sym-
bol, add a note. 

 
NOTE ICON appears on the symbol even when not selected, if you hover over a note icon contents will 
appear on your screen.  
 

1. Click once outside of the text box and a note icon appears on the symbol. 
2. Move your mouse pointer over the NOTE icon to view the note text. 
3. To edit a note click on the icon and change text.  
4. Click outside the text box to save the text. 
 
 
 
 

Making a Symbol Transparent 
Used to reflect the relative importance of the ideas or facts your symbols may represent, order events timeline, 
show relationships… 
1. Select filled symbol 
2. Select Format> Transparency and degree of transparency or right mouse click Transparency and set the 

amount. 
 
Adding a Shadow to a Symbol 
1. Select symbol 
2. Select Shadow from Format menu 
3. Click a Shadow Direction button 
4. Add a colour 
 

 
Using Clip Art as a Symbol  
 

 
 
 
 
 
 
 

To resize click and drag on the diagonal lines. 

Using an Imported Image as a Symbol 
1. Select one or more symbols 
2. Select> Image from File from the INSERT 

menu 
3. Browse to your file 
4. Open 
5. To add text double click on  photo 
6. A text box 

will appear. 
7. Add text> 

Enter 
 

Navigate  
Select category. 

Double click or click and drag to workspace or use 
the insert button below. 

Add your own clip art category 



Importing Images into the Clip Art Gallery 
1. Select Clip Art Button 
2. Click Customize Button below> Add Clip Art 
3. Browse to image (select multiple files use CRTL key or Shift Key) 
4. Open 
5. The Select Category dialog box appears 
6. Click Custom Categories or ADD NEW CATEGORY 
7. OK 
 
To Delete an Image or Category 
1. Select an image >Select Delete Clip Art from Customize menu. 
2. OK 
 
Search for Clipart 
1. Select Clip Art 
2. Category> All Categories 
3. Enter a keyword in the Keyword Box 
4. Click Search 

 
Interactive CLIPLETS 
These animated clip art will assist in teaching geometry, clock 
reading, metric/imperial measurements and basic arithmetic princi-
ples.  They include timers, a pair of dice, teaching clocks, and a 
complete calculator. 
1. From Insert Menu, select Cliplet>opens Chiplet Gallery 
2. Click the Category scroll down button 
3. Select Chiplet 
4. Click insert 
5. Tack the button in place-click the Tack button in the upper left 
corner of the selection rectangle 
6. You can also do a search in the KEYWORDS field 
 
Time Related Cliplet 
 
 
 
 

 
 
 
 
 

 

To Lock into place. To Maximize 



Using the Workspace Grid 
1. Select Grid from the view menu 
2. When Grid is on>every object will be place in the center of the grid box 
3. When Grid is off> you have free moving control 
 
Changing Background Colour 
1. View> Background Colour 
2. You may also decide to create a custom colour 
 
Using Zoom 
1. Click Zoom Button 
2. Use slider 
3. Click Scale to Fit to view all of the objects in the workspace 
 
Working with Text 
1. Begin to type in your symbol 
2. ENTER key when your finished 
3. To insert a line>ALT +ENTER 
4. To edit>double click onto the symbol 
5. Check Spelling>Tools menu 
6. Finding and Replacing Text>in edit menu 
 
Adding Layers and Links to Diagrams 
When would you create a sub-level… 

• Illustrate or expand information 
• Hide information 

 
1. Select a symbol 
2. Click on the green arrow (OPEN SUB-LEVEL) 
3. This will open a new, blank workspace you can create a diagram, write a few lines of illustrated 

text, insert a picture. 
4. Click BACK to return to the previous level 
 

Creating Links to Web Sites, Files or 
Other Diagram Levels 
You can only create only one link per sym-
bol. 
After you add a hyperlink to a symbol, a 
Link icon appears in the lower left level for 
that link. 
 
 
  
 
 

 
 
 
 
 
 

Click to create sub-level 

Shortcut-the file remains on 
your hard drive on your net-
work and is opened from that 
location. 

Attachment-file be-
comes attached to 
SMART ideas project 
file. 

www.hwdsb.on.ca 

Adding a file to your Smart Ideas. 



File Management 
To create a file 
1. Select NEW from the FILE menu 
2. Click open (template)
3.   Files saves as .ipr     To save organizer as a template, save with .ipt file extension. 
 
To export-EXPORT Diagram View to Web 
EXPORT Outline View to Web (text) 
EXPORT to Word Document; 
 
 
 
Quick Connect 
1. Select Quick Connect 
2. Select your symbol 
3. Click on the down arrow in layout and select one of the icons 

4. Begin to type  
5. Click enter  
6. Your new symbol will appear labeled 
7. Continue to type in the same text box until 
you have developed your graphic organizer. 
 
When finished click off of the Quick Connect 
and edit your organizer as you wish.

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Instructions created by DeWalker - HWDSB using Smart Ideas documentation 
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SYSTEM REQUIREMENTS 
 
Windows:     Pentium 150 MHz or faster; 256-colour monitor; minimum 20 MB hard drive   
                    space; 24 MB RAM; Sound Blaster® or compatible sound card for speech; CD 
                    drive or installation 
Macintosh:   PowerPC or faster; Mac OS 8.6 to 9.x; 256-colour monitor; 20 MB hard drive 
                    space; 24 MB RAM; CD drive for installation 
 
INSTALLATION 
 
Windows:     1. Insert CD into drive. 2. Double click on My Computer icon on computer        
                    desktop. 3. Double click on WOL v3 CD icon.  4. Follow on-screen instructions. 
Macintosh:   1. Insert CD into drive. 2. Double click on WOL v3 CD icon. 3. Double click on  
                    WOL UK Installer folder. 4. Double click on WOL v3 Installer icon. 5. Follow on-
                    screen instructions. 
  
GETTING STARTED 
 
Windows:     To launch (startup) Write: Outloud, click the Start button, click Programs,    
                    click Write Outloud v3.   
Macintosh:   Open the WriteOutLoud v3 folder, double click Write:Outloud icon. 
 
FEATURES 

Write 
Outloud 

A talking word processor that 
includes a ‘talking’ easy-to-
use toolbar. Users can add 
pictures, spell check text, 
and have text read back in 
various ways. 

• ‘Talking toolbar’ - pass the mouse over each 
button to hear and see its label 

• Reads back text in various ways: by letter, word, 
sentence, paragraph and whole document; these 
options are configured in the Speech menu 

• Grow and shrink words and pictures 
• Franklin Spell Checker and Dictionary—identifies  

errors, with option to hear suggested words 
spoken aloud by clicking speaker button; also 
includes visual and auditory cues fro misspelled 
words 

 

• Toggle through a variety of  background and text 
colours by clicking the button repeatedly 

• Saved Write Outloud files can be opened by 
either a Windows or Mac computer 

• Choose from a variety of speech voices (in the 
Speech menu >>> Voice Settings) 

• Change the pronunciation of mispronounced words 
(Speech menu >>> Pronunciations >>> Add >>> in  
Key field, type the word >>> in the Translation 
field, type the phonetic spelling >>> OK 

• Single, double or triple space your document (in 
the Options menu) 
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Write: Outloud 
 
 
 
 
 
 
 
 
 

 
 
 
To change speech settings (how the text is 
read back to you while you are typing), click 
on the Speech menu and toggle on or off the 
desired choices. In the example below, each 
word is spoken after it is typed. Also at the 
end of each sentence, the sentence is read 
back. As well, each word is highlighted as it 
is read. 
 
 
 
 
To save a document on Windows computer, click on the Save button; give the document a 
filename and locate where you’d like to save the file in the Save in window. Then click Save. 
To save a document on a Macintosh computer, click the Save button, give the document a name 
in the Save As window. To save the file to a location other than the WriteOutloud program, 
click the New button to select a different location. 
 
To change the default settings of how the text, background, speech voice, etc., appears when 
WOL is started up, launch Write Outloud, make the changes to the settings, then click on the 
Options menu and select Save As Default. The WOL program will now launch with the new  
settings in place. 
 
Copy and paste text from the Internet or from another file and paste it into Write Outloud. 
Highlight the text, then click the Speech button to have this information read back. 
 
***Full Write: Outloud manual is available on the CD. 

Grow and 
shrink words 
and pictures 

Align text Toggle through 
background colours 

Toggle through text 
colours 

Check spelling; 
use dictionary 

Print one copy 

Save file Add 
pictures 

Go to 
beginning 

Highlight 
sentences 

Scroll through 
sentences. Go to end 

Speak text (with 
cursor at 

beginning of story 
or sentence) 

Repeat 
last 

sentence 
Stop 

speech 
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SYSTEM REQUIREMENTS 
Windows:     Pentium 150 PC or higher; Windows 95, 98 or XP; 256-colour monitor; minimum 4 
                    MB hard drive space; 4 MB RAM; Sound Blaster® or compatible sound card for 
                    speech; ViaVoice 4.3 and DJSA Speech 2 (supplied with Co:Writer installer) 
Macintosh:   Power Macintosh or faster; Mac OS 7.6.1 to 8.x or 9; 256-colour monitor; 4 MB 
                    hard drive space; 4 MB RAM; MacinTalk 3 (supplied with Apple system software) 
INSTALLATION 
Windows:     1. Insert CD into drive. 2. Double click on My Computer icon on computer       
                    desktop. 3. Double click on Co:Writer 4000 CDicon. 4. Double click on UK English 
                    Installer folder. 5. Double click on the Co:Writer Setup icon. 6. Follow on-screen 
                    instructions. 
Macintosh:   1. Insert CD into drive. 2. Double click on Co:Writer 4000 CD icon.  3. Double click 
                    on UK English Installer folder. 4. Double click on Co:Writer 4000 Installer    
                    icon.  5. Follow on-screen instructions. 
 GETTING STARTED 
Windows:     To launch Co:Writer 4000, click Start button, click Programs, click Co:Writer.  
Macintosh:   Open the Co:Writer 4000 folder, double click Co:Writer icon. 
 
1. The first time a user launches Co:Writer, on 

the startup screen, click the <Next> button and 
type a username. (Unless otherwise directed, 
Writer files are saved in Co:Writer in the 
user’s folder.) Then click <Next>.   

2. Select the appropriate level of vocabulary for 
the user, then <Next>. Then select the Support 
Level.  

 
3. Co:Writer is a companion to a word 

processor. Choose ‘Word Pad’ as your word 
processor or click in ‘Choose an application’ 
>>> OK. This launches the Start menu so you 
can open a word processor of your choice.  

     Remember to open Co:Writer first and  
     choose the word processor from the Co: 
     Writer Connection window. 
 

Co:Writer 4000 
Word-prediction software 
that is used with a word 
processor of your choice 



M.Legault—HWDSB 

4. When you start typing, the words appear in the Co:Writer  
    window. Unless you have specified otherwise,  predicted  
    ’guesses’ will appear.  
There are 3 ways to select words in the prediction list: 
• Use the arrow keys to scroll to a word, then press 

<Spacebar> to select it 
• Click the mouse on the word choice 
• Type the number of the word choice (if numbers do not 

appear, click on the Format menu at the top of the Co:
Writer window >>> Show Numbers). 

5. Once you type ending punctuation or press <Enter>, the text appears in the word processor 
and the Co:Writer window disappears. To activate the Co:Writer window 
again, click on the icon that appears on the screen. 

6. If the text does not appear in the word processor, a connection needs to 
be set up.  To do this, select Options in the Co:Writer menu, then select 
Change Connections.  

7. Select the word processor (that 
you have opened) from the list 
that appears >>> OK. Now when 
you type, the text should appear 
in the word processor after 
typing a period or pressing 
<Enter>. 

8. Change the voice that reads the 
text back in the Speech menu >>> 
Voice Settings. Also control the 
rate of speaking and volume here.  

9. In the Format menu, you can choose the number 
of  guesses that will appear (0-9) and also how the 
guesses are arranged on the screen.  If Predict as 
Needed is turned on, the user must press the 
right arrow key to activate the guess list. 

10. If Flexible Spelling is turned on (in Options menu), 
Co:Writer displays guesses that are similar to the 
spelling entered, even if some letters are omitted 
by the user. (For flexible spelling, you can choose 
to always use it, never, after 2 letters, or after 3 letters.) 

11. For a specific Topic Dictionary (in Dictionaries menu), click on the red triangle beside the 
heading to view topics. Check the appropriate box(es). Active topic dictionaries are stored 
as part of the user’s writer file and will be loaded until deselected. You can also create your 
own topic dictionary using the Topic Dictionary Toolkit. Access the Help menu or see the 
full manual on the Co:Writer CD for more information. 
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GETTING STARTED 
 
1. Launch Clicker 4.  The first time you use the program, click on the Add User tab and type 

your first and last name. Click Add.   
 
2. You must decide where you want your 

user folder to be stored.  If you are 
working on the school network, click on 
the second radio button. 

 
• Click the Browse button and change to 

the H: drive.  This will save the files 
into your personal directory.  

• If you are on a standalone computer, 
leave your user folder in the Clicker 4 
folder. 

 
 
CREATING A CUSTOM GRID IN CLICKER 4 
 
Depending on if you have used the program 
before, do one of the following: 
 
1. Click on the            icon, then Make a Clicker Grid. 
 
     OR 
 
     Click on the new grid icon. 
 
 
 
 
 
 
   

Clicker 4 
A talking word processor that 
assists students to write with 
words, phrases and pictures. 
Clicker 4 includes Clicker 
Writer (the word processor) 
and Clicker Grids (the cells 
containing text and graphics). 
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2. Click on OK to select the 
default 5x4 grid. 

 
OR, click on one of the 
template tabs across the top 
of the window. Note that some 
of these grid templates are 
used on their own and cannot 
be sent to the Clicker Writer. 
 
OR, click on the Custom button 
to select the number of 
columns and rows that you want 
your grid to be. 
 
Type in the desired 
number for the cells  
in your grid, then  
click OK. The ‘Gap’  
number determines 
the thickness of the 
line between cells. 
 
 
3. To enter words and pictures into 

a cell, hold the <Shift> key 
down and click in the cell with 
your left mouse button. The 
flashing I-beam (cursor) 
appears.  Type the word and 
press the <Enter> key.  There 
are 1000  ready-made pictures 
in Clicker4 that will appear when 
you press the <Enter> key.  If no 
picture appears, it might be because a) there is no ready-made picture b) ‘auto import’ of 
pictures is not turned on.  

 
To turn on the automatic import of ready-made pictures 
• Hold the <Shift> key down and right mouse click on the cell. Click on the Instant Picture 

button, then click OK.  Now retype the text in the cell and the picture should appear.  If it 
doesn’t, it means that there is no ready-made picture built into Clicker4 and you  might 
want to import a picture from another file. 



3 M.Legault—HWDSB 

4. When you have 
completed the 
grid, remember 
to save it.  
• Click on File in 

the top menu 
• Select Save 

Grid As  
• Type a 

filename  
• Select the 

drive (H:, if on 
the network) 
and 
appropriate 
user folder 

• Click the Save 
button 

 
 
 
 
 
 
 
 
 
 
 
 
Hold the <Shift> key down and right 
mouse click in a cell to access the 
Cell Properties window.  You can add 
a graphic from a file, add a sound 
(midi format) or video (avi format) 
to a cell. 
 
 
 
 

THE GRID TOOLBAR 

Move between grids 

Opens the Clicker4 
Home grid OR the 
users own home grid. 

Opens Clicker 
Explorer 

Opens Clicker 
Wordlist 

Deletes the last 
character 

Sorts cells 
alphabetically  

Deletes the last word 

Begins a new line 
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FUNCTION PROCEDURE 

To type in a cell grid Hold the <Shift> key down and left mouse click 
in the cell to get the flashing I-beam 

To hear the text in a cell spoken Right mouse click in the cell 

To have ready-made pictures automatically 
appear in the cell with the text 

Hold the <Shift> key down and right mouse 
click in the cell. Click on the Instant Picture 
button. 

To turn off the ‘Instant Picture’ feature Select Options from the top menu>>> User 
Preferences. Unclick the box beside, “Instant 
pictures for cells”. 

To type in Clicker Writer with no pictures 
appearing when you type 

Select Options from the top menu>>> User 
Preferences. Unclick the box beside, “Instant 
pictures as you type”. 

To hide/show the grid when typing in Clicker 
Writer 

Click on the grid icon in the top button bar...
it’s a toggle (on/off) button. 

To remove a picture from a cell Hold the <Shift> key down and right mouse 
click in the cell. Click on the Remove Graphic 
button. 

To use a grid in Clicker Writer if Clicker 
Writer is not available on the screen. 

Click on Grid in the top menu, select Grid 
Properties.  Select the Send to tab, then click 
in the radio button beside ‘Send to Clicker 
Writer’. Click OK. 

To move objects Hold the <Alt> key down and drag the cell or 
object 

To delete a cell Right mouse click to highlight; click on Grid in 
top menu, select Delete >>> Cell (whole cell is 
deleted) 

To insert a cell, text box or graphic box Click on Grid in top menu, select Insert >>> 
Cell, etc. 

To access additional ready-made grids on the 
Internet 

Go to: www.learninggrids.com 
Click on the desired subject in the list on the 
left side of the screen, then choose a topic. 
You need to complete a free registration in 
order to download grids. 
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